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保証 9（b）

当社では、ソフトウェア製品を提供する目的で使用されているメディア、およびそのメディア上のプログラムの
エンコードにおいて、出荷の日から 3 か月間、材料およびその仕上がりについて欠陥がないことを保証しま
す。この保証期間中にメディアまたはエンコードに欠陥があることが判明した場合、当社では、当該欠陥メ
ディアの交換品を提供します。ソフトウェア製品を提供する目的で使用されているメディアを除き、本ソフト
ウェア製品は、明示的保証または暗示的保証を問わず何等保証のない "現状有姿" のまま提供されていま
す。当社では、本ソフトウェア製品に含まれる機能がお客様の要求を満たすこと、プログラムの動作が中断
されないこと、エラーが発生しないことのいずれも保証いたしません。

本保証に基づきサービスをお受けいただくため、お客様には、本保証期間の満了前に当該欠陥を当社に
通知していただきます。お客様から通知を受けた後、妥当な期間内に材料およびその仕上がりに欠陥がな
い交換品を提供できない場合、お客様は、本ソフトウェア製品のライセンスを終了して本製品とその関連材
料を返却し、お客様が既に支払った代金を払い戻すことができます。

この保証は、明示的または黙示的な他のあらゆる保証の代わりに、製品に関して当社がお客様に対して提供す
るものです。当社およびベンダは、商品性または特定目的に対する適合性についての一切の黙示保証を
否認します。欠陥メディアの交換またはお客様が支払った代金払い戻しを行う当社の責任は、本保証の不
履行についてお客様に提供される唯一の排他的な法的救済となります。間接損害、特別損害、付随的損
害または派生損害については、当社およびそのベンダは、損害の実現性を事前に通知されていたか否に
拘わらず、一切の責任を負いません。
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安全にご使用いただくために

安全にご使用いただくために

人体への損傷を避け、本製品や本製品に接続されている製品への損傷を防止するために、次
の安全性に関する注意をよくお読みください。

安全にご使用いただくために、本製品の指示に従ってください。

資格のあるサービス担当者以外は、保守点検手順を実行しないでください。

本製品をご使用の際に、規模の大きなシステムの他の製品にアクセスしなければならない場合がありま
す。 システムの操作に関する警告や注意事項については、他製品のコンポーネントのマニュアルにあ
る安全に関するセクションをお読みください。

火災や人体への損傷を避けるには

接続と切断は正しく行ってください。 プローブ出力を測定機器に接続してから、プローブを被測定
回路に接続してください。 被測定回路にプローブの基準リードを接続してから、プローブ入力を接
続してください。 プローブ入力とプローブの基準リードを被測定回路から切断した後で、プローブ
を測定機器から切断してください。

すべての端子の定格に従ってください。 火災や感電の危険を避けるために、本製品のすべて
の定格とマーキングに従ってください。 本製品に電源を接続する前に、定格の詳細について、
製品マニュアルを参照してください。

共通端子を含むどの端子にも、その端子の最大定格を超える電位をかけないでください。

カバーを外した状態で動作させないでください。 カバーやパネルを外した状態で本製品を動作
させないでください。

障害の疑いがあるときは動作させないでください。 本製品に損傷の疑いがある場合、資格のある
サービス担当者に検査してもらってください。

回路の露出を避けてください。 電源がオンのときに、露出した接続部分やコンポーネントに触れ
ないでください。

湿気の多いところでは動作させないでください。

爆発しやすい環境では動作させないでください。

製品の表面を清潔で乾燥した状態に保ってください。

本マニュアル内の用語

本マニュアルでは、次の用語を使用します。

警告： 「警告」では、怪我や死亡の原因となる状態や行為を示します。

注意： 「注意」では、本製品やその他の資産に損害を与える状態や行為を示します。
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まえがき

まえがき

TDSHT3 HDMI コンプライアンス・テスト・ソフトウェアは、当社のオシロスコープで動作する HDMI（High
Definition Multimedia Interface）コンプライアンス・テスト・ソリューションです。このソフトウェアを使用する
と、HDMI 物理層の検証とコンプライアンス・テストを実行できます。

注： TDSHT3 には、2 つのアプリケーションが用意されています。1 つは CTS 1.2a 仕様をサポートする
バージョン（TDSHT3）で、もう 1 つは CTS 1.3a 仕様をサポートするバージョン（TDSHT3v1.3）です。どち
らのアプリケーションも、オシロスコープにロードできますが、一度に実行できるのは 1 つのアプリケー
ションのみです。CTS1.2a 仕様をサポートしている TDSHT3 の詳細については、『TDSHT3 HDMI クイッ
ク・スタート・ユーザ・マニュアル』（当社部品番号 071-1961-01）を参照してください。

主要な機能

HDMI 1.3 規格とテスト仕様（CTS バージョン 1.3）に準拠することにより結果の信頼性を保証

ソース、シンク、およびケーブル・デバイスに対する広範囲なテストにより、規格についてのす
べての妥当性を検証

確度の高い測定技術を使用した、正確なソース・テスト

機器設定の非線形性を除去するクローズドループ測定を使用した、信頼性の高いシンク・テスト

信号ソースのリモート・コントロールによる、自動化されたシンク・テストとケーブル・テスト

自動マスク調整、測定、および合格または不合格の通知

統計分析とマスク・マージンによる詳細な分析

1 つのボタン操作による複数のテストの実行

1 つのボタン操作による CSV 形式のサマリとレポートの作成

精密なテスト・フィクスチャ、信号ソース、および TDR を使用する、完全なコンプライアンス・ソ
リューション
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マニュアル

このマニュアルでは、TSDHT3 ソフトウェアのインストールと基本的な操作について説明します。詳細に
ついては、オンライン・ヘルプを参照してください。この製品では、次の資料が利用できます。

TDSHT3 オンライン・ヘルプ

Start > Programs > TekApplications > TDSHT3v1-3 > Help

TDSHT3 オンライン・ヘルプ
（PDF）

『TDSHT3 Quick Start User
Manual』、英語（PDF）

『TDSHT3 クイック・スタート・
ユーザ・マニュアル』、日本
語（PDF）

『TDSHT3 クイック・リファレ
ンス・カード、ソース・テスト』
（PDF）

『TDSHT3 クイック・リファレ
ンス・カード、シンク・テスト』
（PDF）

C:\ProgramFiles\TekApplications\TDSHT3v1-

3\Manuals

http://www.tek-

tronix.com

インストール・マニュアル：
『Windows ベースのオシロス
コープ上で動作するオプショ
ン・アプリケーション・ソフト
ウェア』

ソフトウェアのアップグレード

ソフトウェアは定期的にアップグレードできます。特定のオシロスコープ・モデルとシリアル番号に対して
有効なオプション・キーを所有している場合にのみ、ソフトウェアが動作します。

アップグレードを確認するには：

1. Tektronix ホームページ（www.tektronix.com）にアクセスします。

2. Software and Drivers を選択します。

3. 製品名（TDSHT3）を入力します。
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ソフトウェアのインストール

ソフトウェアのインストール

TDSHT3 ソフトウェアは、当社のオシロスコープにインストールする必要があります。次のモデルがサ
ポートされています。

TDS7254 型および TDS7254B 型

TDS7404 型および TDS7404B 型

CSA7404 型および CSA7404B 型

TDS7704B 型

TDS6604B 型

TDS6804B 型

TDS6124C 型

TDS6154C 型

DPO70404 型および DSA70404 型

DPO70604 型および DSA70604 型

DPO71254 型および DSA71254 型

DPO71604 型および DSA71604 型

DPO72004 型および DSA72004 型

DPO70804 型および DSA70804 型（推奨）

インストールする前に

オシロスコープには TekVisa をインストールしておく必要があります。TekVisa をお持ちでない場合
は、Tektronix Web サイトの Software Upgrades と同じページからダウンロードできます。 (v ページ
「ソフトウェアのアップグレード」 参照)。

ソフトウェアをインストールする前に、製品ソフトウェア CD に含まれている Readme.txt ファイ
ルをお読みください。

インストール

1. すべてのアプリケーションを終了します。

2. オシロスコープの CD ドライブに製品ソフトウェア CD を挿入します。

3. インストール・ウィザードに従って、インストールを実行します。アップグレードの場合は、新しいバー
ジョンをインストールする前に既存のソフトウェアが自動的に削除されます。

4. ソフトウェア・ファイルは、C:\Program Files\TekApplications\TDSHT3v1–3 にインストール

されます。
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ソフトウェアのインストール

オシロスコープへの接続

テストごとに、個別の機器設定とテスト・アダプタが必要です。テストするデバイスとテスト機器をオシ
ロスコープに接続する方法については、接続ペインの More をクリックしてください。次のテスト・ア
ダプタが必要です。

Efficere Technologies 社製品の EFF - HDMI - TPA - R（推奨）

Efficere Technologies 社製品の EFF - HDMI - TPA - P（推奨）

以下のテスト・フィクスチャは、限られた HDMI テストにのみ使用できます。

当社 HDMI TPA-P-DI（Eye Diagram を除く差動ソース・テスト用）

当社 HDMI TPA-P-SE（シングルエンド・ソースのテスト用）

当社 HDMI TPA-P-TDR（TDR テスト用）およびソース・テスト（ Eye Diagram ）

当社 HDMI TPA-R-DI（ケーブル・テストおよびシンク・テスト用）

当社 HDMI TPA-R-SE（ケーブル・テストおよびシンク・テスト用）

当社 HDMI TPA-R-TDR（TDR テストおよびシンク・テスト用）
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ソフトウェアのインストール

ソフトウェアの起動

TDSHT3 ソフトウェアを起動するに
は、次の手順に従ってください。

1. TDS7000 シリーズのオシロス
コープの場合は、File > Run
application > HDMI Compliance
Test Software(1.3)の順に選択
します。

2. TDS B シリーズおよび TDS C
シリーズのオシロスコープの場
合は、App > HDMI Compliance
Test Software(1.3)の順に選択
します。
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ソフトウェアのインストール

3. DPO70000 シリーズおよび
DSA70000 シリーズのオシロ
スコープの場合は、Analyze
> HDMI Compliance Test
Software(1.3)の順に選択しま
す。

4. オシロスコープ表示が、スク
リーンの上側に収まるようにサ
イズ変更されます。

5. ディスプレイの下側にソフトウェ
アが表示されます。

注： 正確な結果を得るために、テストを実行する前にプローブとオシロスコープを校正してください。
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ソフトウェアのインストール

プローブとオシロスコープの

校正

6. Utilities > Instrument

Calibration の順にクリック
し、信号パスを補正するために
オシロスコープの校正を開始
します。

7. Calibrate をクリックします。

8. Vertical > Probe Cal の順に選
択し、プローブの校正を開始
します。

9. プローブ校正信号をプローブ
に接続します。

10.Calibrate Probe をクリックしま
す。

TDSHT3 HDMI コンプライアンス・テスト・ソフトウェア・クイック・スタート・ユーザ・マニュアル 5



ソフトウェアのインストール

ソフトウェアの終了

1. File > Exit の順に選択します。

2. 終了アイコンをクリックして終了
することもできます。

これ以外の方法でソフトウェア
を終了すると、異常終了する場
合があります。

3. ソフトウェアの終了時に、
TDSHT3 ソフトウェアによって
変更されたオシロスコープの設
定を元に戻すことができます。
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ソフトウェアの概要

ソフトウェアの概要

インタフェースの使用

TDSHT3 ソフトウェアで選択操作を行うには、キーボード、マウス、またはタッチスクリーンを使用します。

ソフトウェアの機能を使用するには、メニュー、チェック・ボックス、および画面上のボタンを使用します。
メニューを選択したりチェック・ボックスをオンまたはオフにしたりする場合は、Microsoft Windows の操
作方法に従います。

仮想キーボード

1. New をクリックします。

2. 表示されているテキストをクリ
アし、新しいテキストを入力し
ます。

3. Enter キーをクリックし、選択内
容を確定します。

注： 仮想キーボードの Enter キーをクリックするまで、選択内容は有効になりません。
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ソフトウェアの概要

仮想キーパッド

1. 目的の数値ボックスをクリック
します。

2. キーパッド・アイコンをクリック
します。

3. 表示されている値をクリアし、
目的の値を入力します。

4. 測定の単位を選択します。

5. Enter キーをクリックし、選択内
容を確定します。

注： 仮想キーパッドの Enter キーをクリックするまで、選択内容は有効になりません。

汎用ノブ

1. 目的の数値ボックスをクリック
し、汎用ノブとの関連付けを表
示します。

2. オシロスコープの前面パネル
にある対応するノブを回し、選
択したパラメータの値を調整し
ます。

3. 分解能を向上させるには、
FINE ボタンを押します。
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ソフトウェアの概要

基本機能の設定

1. TDSHT3 ソフトウェアのメ
ニュー・バーから、File >

Preferences の順にクリックし、
オプションを選択します。

2. 選択内容をクリアする場合は、
オプションをもう 1 度クリックし
ます。

オプション 説明

Position Eye Mask in Center これを選択すると、Eye Diagram の中央にマスクが配置されます。
選択を解除すると、Eye Diagram の左側にマスクが配置されます。

Acquisition Alert Message これを選択すると、アラートが表示されて、テストを実行するオシ
ロスコープの設定を指定するように要求されます。
選択を解除すると、TDSHT3 ソフトウェアが自動的にオシロス
コープの設定を選択します。

Jitter Tolerance（No calibration） これを選択すると、アプリケーションは、シンク・ジッタ公差測定
のためのジッタ校正を実行しません。
選択を解除すると、アプリケーションは、シンク・ジッタ公差測定
のためのジッタ校正を実行します。

Single Ended (With 50 ohm term) このオプションは、プローブのマイナス入力が50Ωターミネー
ションで終端されている場合にのみ選択できます。

これを選択すると、50Ωターミネーションが接続されているかの
ように、アプリケーションがシングルエンド測定を実行します。
選択を解除すると、アプリケーションは、50Ωターミネーションな
しでシングルエンド測定を実行します。
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ソフトウェアの概要

TDSHT3 ソフトウェアの非表示と再表示

1. TDSHT3 ソフトウェアを最小化
してオシロスコープの表示を拡
大するには、"非表示"アイコン
をクリックします。

TDSHT3 ソフトウェアを再表示す
るには：

2. TDS7000 シリーズのオシロス
コープの場合、APP ボタンを
選択します。
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ソフトウェアの概要

3. TDS6000B/C シリーズおよび
TDS7000/B シリーズのオシ
ロスコープの場合は、App >

Restore Application の順に選
択します。

4. DPO70000 シリーズのオシロ
スコープの場合は、Analyze >

Restore Application の順に選
択します。
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TDSHT3 HDMI ソフトウェアの使用

TDSHT3 HDMI ソフトウェアの使用

テスト：操作手順

テストを実行する際は、手順 1 ～ 6 までの一連の操作手順に従ってください。これらの操作の詳細に
ついては、この後のセクションで説明します。

1. テストを選択します。

2. テスト・パラメータを設定しま
す。

3. 機器を接続し、設定します。

4. 波形を表示してテスト信号を
検査します。

5. テストを実行します。

6. テスト結果を分析します。

7. レポートを生成します。

注： 正確なテスト結果を得るためには、テストを実行する前にオシロスコープとプローブを校正してく
ださい。 (5 ページ 「プローブとオシロスコープの校正」 参照)。

テストの選択

1. Select をクリックします。

2. Source タブ、Sink タブ、または
Cable タブをクリックします。

3. テスト名の近くにマウスを移動
して、テスト ID を表示します。
この ID は、HDMI コンプライア
ンス・テスト仕様のテスト ID に
対応しています。

4. 実行するテストを選択します。

複数のテストを選択できます
が、これらはすべて同じ種類に
する必要があります。

5. 特定の種類のテストをすべて
選択するには、Select All をク
リックします。
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TDSHT3 HDMI ソフトウェアの使用

テスト・パラメータの設定

1. Configure をクリックします。

2. 必要に応じて、仮想キーボー
ドまたはオシロスコープの前面
パネルにある汎用ノブを使用し
て値を変更します。

File メニューを使用すると、出
荷時のデフォルト値に戻した
り、独自の設定内容を保存して
呼び出したりできます。

機器の接続と設定

注： テストでリモート・コントロールを使用する場合は、オンライン・ヘルプのセットアップ・ダイアグラムに
ある、E-net 接続を使用したテスト機器の接続方法を参照してください。この方法だけでなく、GPIB-B
接続を使用することもできます。(36 ページ 「テスト機器のリモート・コントロールの有効化」 参照)。 テス
トの例は、「測定例」のセクションに示されています。 (20 ページ参照)。

1. Connect をクリックします。

2. 画面上の指示に従って、テスト
するデバイスとテスト機器を接
続し、設定します。

3. More をクリックすると、選択し
たテストに関するオンライン・ヘ
ルプが表示されます。このヘル
プには、セットアップ・ダイアグ
ラムが含まれています。セット
アップ・ダイアグラムに示されて
いるように、テスト機器を接続
します。

4. 選択したテストで AWG/AFG お
よび DTG を使用する場合は、
Signal Sources を選択し、テスト
機器を設定します。 (36 ペー
ジ 「テスト機器のリモート・コン
トロールの有効化」 参照)。
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TDSHT3 HDMI ソフトウェアの使用

波形の表示

1. View Waveform をクリックします

（テストによっては使用できな
いことがあります）。

2. 画面上部の波形が、TDSHT3
ソフトウェアで表示される波形
に似ていることを確認します。

表示された波形が似ていない
場合は、設定と接続を確認し
てください。

テストの実行

1. Run Test をクリックします。

2. テストが実行され、プログレス・
インジケータが表示されます。
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TDSHT3 HDMI ソフトウェアの使用

テスト結果の分析

1. テストが完了すると、テスト結果
のサマリが表示されます。デバ
イスがテストに合格したかどうか
を確認します。

合格

不合格

エラー

デバイスがテストに合格しな
かった場合、 2から 8までの手
順に従って問題を解決し、もう
1 度テストを実行します。

2. Result Details をクリックすると、
テスト結果の詳細がスプレッド
シート形式で表示されます。

3. Remarks の列を確認します。エ
ラー・コードが表示されている
場合、オンライン・ヘルプでそ
のエラー・コードの説明を参照
してください。

注： Result Details ダイアログ・ボックスのパラメータは、実行するテストによって異なります。

TDSHT3 HDMI コンプライアンス・テスト・ソフトウェア・クイック・スタート・ユーザ・マニュアル 15



TDSHT3 HDMI ソフトウェアの使用

Eye Diagram テストを実行した場
合は、プロットが表示されます。こ
の画面では次の操作を実行でき
ます。

4. 画像を C:\TekApplica-
tions\TDSHT3v1-3\Images に
保存します（このパスは変更可
能です）。

5. 拡大または縮小します。

6. ヒストグラムを表示します。

7. マスクを移動して、誤差の範囲
を確認します。

8. 統計情報を表示します。

9. プロットを 1/2 スクリーン・サイ
ズに変更します（テスト結果の
サマリが表示されます）。

10.クロック・ジッタ・テストを実行し
た場合にもプロットが表示され
ます。このプロットでは、クロッ
クのピーク・ツー・ピーク・ジッタ
が表示されます。
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TDSHT3 HDMI ソフトウェアの使用

レポートの生成と印刷

以下に説明する方法で、サマリ・レポートまたは詳細レポートを生成し、印刷できます。

レポート・ゼネレータを使用すると、カスタマイズされたレポートを作成し、印刷することもできます。ファ
イルは RTF 形式や、RGT、RPL、RPT といった独自のファイル形式で保存できます。レポート・ゼネ
レータの詳細については、オンライン・ヘルプを参照してください。

サマリ

1 つまたは複数のテストが正常に終了すると、レポート・サマリを .csv ファイルとして生成できます。

1. 実行ペインの Summary をクリッ
クします。

2. レポート・サマリが保存された
場所を示すメッセージが表示さ
れます。

3. このファイルを開き、レポート
を印刷します。

詳細

テストの実行後に、デフォルトの情報や独自に設定した情報を含むレポートを生成できます。

1. Result をクリックし、レポートを
設定します（デフォルト設定を
使用する場合は、手順 14 に
スキップしてください）。

2. テストの実行に使用した入力
値を選択します。

3. テストを実行したときの分解能
（40 Hz、43 Hz、57 Hz、60 Hz
など）を入力します。

4. テストを実行したときのリフレッ
シュ・レート（VGA、SVGA、
XGA、SXGA など）を入力しま
す。

5. レポートが保存される場所を確
認します。この場所は必要に応
じて変更できます。

6. レポート生成時にレポートを
画面に表示するには、Enable
Preview を選択します。
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TDSHT3 HDMI ソフトウェアの使用

7. Clear Report をクリックし、すべ
てのレポートをクリアします。今
回のテストで生成されたレポー
トの値がクリアされます。

8. Advanced をクリックします。

9. DUT ID（シリアル番号）を入力
します。

10.DUT の詳細（製品の種類）を
入力します。

11.シングルエンド・テストおよび差
動テストに使用するペアを入
力します。これらのエントリは、
HDMI アダプタのコネクタに対
応しています。セットアップ・ダ
イアグラムを参照してください。

12.このチェック・ボックスをオフに
すると、TDSHT3 ソフトウェアは
レポートに jpeg 画像を表示す
るようにオシロスコープを設定
します。デフォルトの画像エクス
ポート設定を変更する場合は、
オシロスコープの画像エクス
ポート設定を変更し、このチェッ
ク・ボックスをオンにします。

13.OK をクリックします。

14.レポート・ペインの Detail をク
リックし、レポートを生成します。

Enable Preview が選択さ
れている場合、レポート・
ビューア・ユーティリティで
レポートが表示されます。
選択されていない場合は、
レポートが保存された場所
を示すダイアログ・ボックス
が表示されます。

Eye Diagram またはクロック・
ジッタ・テストに対しては、プ
ロットも表示されます。

必要に応じて、レポート・
ビューアの Edit メニューを
使用して、レポートを編集
できます。

レポート・ビューアの File メ
ニューを使用して、レポー
トを印刷したり、レポートを
RTF ファイルにエクスポート
したりします。
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TDSHT3 HDMI ソフトウェアの使用

注： レポートの詳細は現時点のもので、履歴は保持されません。別のテストを実行する前に、レポート
の詳細を保存してください。
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測定例

測定例

Source: Select All（クロック - データテスト）

この項目を選択すると、一連のテストが同時に実行されます。

必要な機器 例

差動プローブ× 2、グランド・リード 当社の P7313SMA/P7350SMA 型（外部回路付属の
P7330/P7350/P7380/P7380SMA 型のみが古いフィクスチャで
使用可能）。
当社部品番号 196-3469-00

3.3 V に設定された DC 電源× 1 Kenwood PW18-1.8AQ

EDID エミュレータ× 1 EFF-EDID PCB（INFO）／ Silicon Image TE9100/Quantum
Data 882CA

入力アダプタ× 1 Efficere Technologies 社製品の EFF - HDMI - TPA - P

プローブ校正／デスキュー・フィ
クスチャ

当社部品番号 067-1478-XX

1. Select をクリックします。

2. Source タブをクリックします。

3. Select All をクリックします。

4. Configure をクリックします。必
要に応じて、これらの値を変更
します（通常はデフォルト値の
ままでかまいません）。
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測定例

5. Connect をクリックします。

6. 機器を接続し、設定します。

セットアップ・ダイアグラムに
示されているように、テスト
機器を接続します。

ソース DUT の出力を、最
初にサポートされるビデオ・
フォーマットに設定します。

EDID チップを持つ Efficere
EDID PCB を接続するか、
EDID エミュレータを必要な
分解能に設定します（EDID
エミュレータのユーザ・マ
ニュアルを参照）。

注： ダイアグラムの のマー
クは、空いている差動 SMA プロー
ブの入力ポートなどのバイアスされ
た 50 Ωターミネーションへの接続
を意味します。
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測定例

7. View Waveform をクリックしま
す。

TDSHT3 ソフトウェアで表示さ
れるものと似た波形がオシロス
コープに表示されることを確認
します。表示された波形が似て
いない場合は、設定と接続を
確認してください。

正確な結果を得るために、テス
トを実行する前にプローブをデ
スキューします。

8. Run Test をクリックします。

9. テストが完了したら、テスト結果
を確認します。 (15 ページ 「テ
スト結果の分析」 参照)。

10.実行したテストに基づいた
レポートを生成できます。
(17 ページ 「レポートの生成と
印刷」 参照)。

11.Data0 入力ペアをテストした
後、Data0 から Data1 にプロー
ブを移動し、テストを繰り返しま
す。Data2 に対してもテストを
繰り返します。

12.EDID エミュレータを次のピク
セル・クロック・レート（VGA、
SVGA など）に設定し、3 種類
のデータ入力ペアすべてにつ
いてテストします。ピクセル・ク
ロック・レートごとに 1 つのビデ
オ・フォーマットを指定します。

13.サポートされるすべてのピクセ
ル・クロック・レートに対して、手
順 12 を繰り返します。
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測定例

Source: Inter-Pair Skew（データ間テスト）

このテストでは、HDMI リンクの TMDS 部分について、差動ペア間のスキューが HDMI 仕様に指定され
た制限内にあることを検査します。

必要な機器 例

差動プローブ× 2、グランド・リード 当社の P7313SMA/P7350SMA 型（外部回路付属の
P7330/P7350/P7380/P7380SMA 型のみが古いフィクスチャで
使用可能）。
当社部品番号 196-3469-00

3.3 V に設定された DC 電源× 1 Kenwood PW18-1.8AQ

EDID エミュレータ× 1 EFF-EDID PCB（INFO）／ Silicon Image TE9100/Quantum
Data 882CA

入力アダプタ× 1 Efficere Technologies 社製品の EFF - HDMI - TPA - P（推奨）

1. Select をクリックします。

2. Source タブをクリックします。

3. Inter-Pair Skew を選択します。

4. Configure をクリックします。必
要に応じて、これらの値を変更
します（通常はデフォルト値の
ままでかまいません）。

5. Connect をクリックします。
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測定例

6. 機器を接続し、設定します。

セットアップ・ダイアグラムに
示されているように、テスト
機器を接続します。

ソース DUT の出力を、サ
ポートされる最高のピクセ
ル・クロック周波数に設定
します。

Efficere Technologies 社製
品の EDID PCB と EDID
チップを接続するか、EDID
エミュレータを必要な分解
能に設定します（EDID エ
ミュレータのユーザ・マニュ
アルを参照）。

注： ダイアグラムの のマー
クは、空いている差動 SMA プロー
ブの入力ポートなどのバイアスされ
た 50 Ωターミネーションへの接続
を意味します。

7. View Waveform をクリックしま
す。

TDSHT3 ソフトウェアで表示さ
れるものと似た波形がオシロス
コープに表示されることを確認
します。表示された波形が似て
いない場合は、設定と接続を
確認してください。
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Tbit 値の再計算：

8. もう 1 度、Configure をクリック
します。

9. ソフトウェアが Tbit 値の再計算
を行うように設定されている（デ
フォルト）ことを確認します。

10.信号のジッタとノイズが多すぎる
場合、このボックスの値を増や
します（デフォルト値は 100）。

11.Run Test をクリックして、
Continue をクリックし、新しい
Tbit 値でテストを実行します。

12.テストが完了したら、テスト結果
を確認します。 (15 ページ 「テ
スト結果の分析」 参照)。

13.実行したテストに基づいた
レポートを生成できます。
(17 ページ 「レポートの生成と
印刷」 参照)。

Sink: Min/Max-Diff Swing Tolerance テスト

このテストでは、最小レベルの TMDS 差動電圧をシンク・デバイスが正しくサポートすることを検査します。

必要な機器 例

デジタル・タイミング・ゼネレータ 当社の DTG5274 型（最大 2.7 Gb）／DTG5334 型（最大
3.4 Gb）、DTGM30 型出力モジュール付属

SMA ケーブル× 8 当社部品番号 174-1341-00、1 m または
当社部品番号 174-1428-00、1.5 m

5.0 V に設定された DC 電源× 1 Kenwood PW18-1.8AQ

入力アダプタ× 1 Efficere Technologies 社製品の EFF - HDMI - TPA - P（推奨）
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1. Select をクリックします。

2. Sink タブをクリックします。

3. Min/Max-Diff Swing Tolerance

を選択します。

4. Configure をクリックします。必
要に応じて、これらの値を変更
します（通常はデフォルト値の
ままでかまいません）。

5. Connect をクリックします。
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6. 機器を接続し、設定します。

セットアップ・ダイアグラムに
示されているように、テスト
機器を接続します。

DTG とオシロスコープを接
続します。 (36 ページ 「テス
ト機器のリモート・コントロー
ルの有効化」 参照)。

7. Run Test をクリックします。

8. 画面上に示される一連のメッ
セージの指示に従います。

9. テストが完了したら、テスト結果
を確認します。 (15 ページ 「テ
スト結果の分析」 参照)。

10.実行したテストに基づいたレ
ポートを生成できます。(17 ペー
ジ 「レポートの生成と印刷」 参
照)。

注： シンク・テストまたはケーブル・テストを実行すると、GPIB バス・タイミングに関する警告が表示
されます。バス・タイミング・パラメータが 2 μs に設定されている場合、OK をクリックして続行してく
ださい。そうでない場合は、Cancel をクリックして、バス・タイミング・パラメータを変更してください。
(41 ページ 「GPIB バス・タイミングの設定」 参照)。

Sink: Jitter Tolerance テスト

このテストでは、最大許容 TMDS クロック・ジッタをデバイスがサポートすることを検査します。

必要な機器 例

デジタル・タイミング・ゼネレータ 当社のDTG5274 型（最大 2.7 Gb）／DTG5334 型（最大 3.4 Gb）、
DTGM30 型および DTGM32（AWG710/AWG710B/AFG3000 で
のみ使用）出力モジュール付属

任意波形ゼネレータ 当社 AWG710 型、AWG710B 型、または AWG7102 型（個別
ジッタ挿入）

任意波形ファンクション・ゼネレー
タ

当社 AFG3102 型、AFG3022 型、AFG3252 型

SMA ケーブル× 12 当社部品番号 174-1341-00、1 m または
当社部品番号 174-1428-00、1.5 m

ケーブル・エミュレータ× 1 CTS1.3 と同じ

バイアス・ティー× 2 ミニ回路 ZFBT-4R2GW
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必要な機器 例

5 V に設定された DC 電源× 1 Kenwood PW18-1.8AQ

入力アダプタ× 2 Efficere Technologies 社製品の EFF - HDMI - TPA - P および
EFF - HDMI - TPA - R

1. Select をクリックします。

2. Sink タブをクリックします。

3. Jitter Tolerance を選択します。

4. Configure をクリックします。必
要に応じて、これらの値を変更
します（通常はデフォルト値の
ままでかまいません）。

5. DTG タブをクリックし、クロック
とデータの入力信号を指定す
る DTG 出力を設定します。

6. Connect をクリックします。
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7. 機器を接続し、設定します。

注： ダイアグラムの のマー
クは、空いている差動 SMA プロー
ブの入力ポートなどのバイアスされ
た 50 Ωターミネーションへの接続
を意味します。

ジッタ生成ブロックを使用
して、既知量のジッタを生
成します（クロック・ジッタ：
0.25 UI、データ・ジッタ：
0.30 UI）。

校正するオシロスコープに
テスト・フィクスチャを接続し
ます。オシロスコープが、既
知量のジッタと共にケーブ
ルとテスト・フィクスチャによ
り挿入されるデータとクロッ
ク・ジッタを計算します。

8. 次のいずれかの方法で機器の
接続と設定を行います。

方法 1a：テスト分解
能≤ 74.25 MHz の
DTG-AWG710/AWG710B
の場合

セットアップ・ダイアグラム
に示されているように、DTG
および AWG にテスト機器
を接続します。

テスト・フィクスチャを DUT
に接続する際は、テストする
ピクセル・クロック・レート用
として指定されたケーブル・
エミュレータを使用します。

「テスト機器のリモート・コン
トロールの有効化」の説明
に従って、DTG、AWG およ
びオシロスコープを接続し
ます。 (36 ページ参照)。

HDMI 入力信号を受信する
ように DUT を設定します。
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方法 1b：テスト分解
能 >74.25 MHz の
DTG-AWG710/AWG710B
の場合

セットアップ・ダイアグラム
に示されているように、DTG
および AWG にテスト機器
を接続します。

テスト・フィクスチャを DUT
に接続する際は、テストする
ピクセル・クロック・レート用
として指定されたケーブル・
エミュレータを使用します。

「テスト機器のリモート・コン
トロールの有効化」の説明
に従って、DTG、AWG およ
びオシロスコープを接続し
ます。 (36 ページ参照)。

HDMI 入力信号を受信する
ように DUT を設定します。

方法 2：DTG-AFG3000 複合
ジッタ挿入

セットアップ・ダイアグラム
に示されているように、DTG
および AFG にテスト機器を
接続します。

テスト・フィクスチャを DUT
に接続する際は、テストする
ピクセル・クロック・レート用
として指定されたケーブル・
エミュレータを使用します。

「テスト機器のリモート・コン
トロールの有効化」の説明
に従って、DTG、AFG およ
びオシロスコープを接続し
ます。 (36 ページ参照)。

HDMI 入力信号を受信する
ように DUT を設定します。

30 TDSHT3 HDMI コンプライアンス・テスト・ソフトウェア・クイック・スタート・ユーザ・マニュアル



測定例

方法 3：すべての周波数の
DTG-AWG7102 複合ジッタ挿
入

セットアップ・ダイアグラム
に示されているように、DTG
および AWG7102 にテスト
機器を接続します。

テスト・フィクスチャを DUT
に接続する際は、テストする
ピクセル・クロック・レート用
として指定されたケーブル・
エミュレータを使用します。

「テスト機器のリモート・コント
ロールの有効化」の説明に
従って、DTG、AWG7102 お
よびオシロスコープを接続
します。 (36 ページ参照)。

HDMI 入力信号を受信する
ように DUT を設定します。
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方法 4：すべての周波数の
DTG-AWG7102 個別ジッタ挿
入

セットアップ・ダイアグラム
に示されているように、DTG
および AWG7102 にテスト
機器を接続します。

テスト・フィクスチャを DUT
に接続する際は、テストする
ピクセル・クロック・レート用
として指定されたケーブル・
エミュレータを使用します。

「テスト機器のリモート・コント
ロールの有効化」の説明に
従って、DTG、AWG7102 お
よびオシロスコープを接続
します。 (36 ページ参照)。

HDMI 入力信号を受信する
ように DUT を設定します。

9. Run Test をクリックします。

10.画面上に示される一連のメッ
セージの指示に従います。

11.テストが完了したら、テスト結果
を確認します。 (15 ページ 「テ
スト結果の分析」 参照)。

12.実行したテストに基づいた
レポートを生成できます。
(17 ページ 「レポートの生成と
印刷」 参照)。

注： シンク・テストまたはケーブル・テストを実行すると、GPIB バス・タイミングに関する警告が表示
されます。バス・タイミング・パラメータが 2 μs に設定されている場合、OK をクリックして続行してく
ださい。そうでない場合は、Cancel をクリックして、バス・タイミング・パラメータを変更してください。
(41 ページ 「GPIB バス・タイミングの設定」 参照)。
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Cable: Eye Diagram テスト

ケーブル・イコライザ

通常の受動銅線ケーブルの信号劣化は、周波数とケーブルの長さによって増長します。このようなケー
ブルからデータを再生するには、TDSHT3 では、クロック周波数が 165 MHz 以上の場合に、HDMI 仕
様 1.3 で示されているようにリファレンス・ケーブル・イコライザを Eye Diagram 測定に適用します。

このテストでは、ケーブル部品から規格に合ったデータ・アイが出力されることを検査します。

必要な機器 例

デジタル・タイミング・ゼネレータ 当社の DTG5274 型（最大 2.7 Gb）／DTG5334 型（最大
3.4 Gb）、3 つの DTGM30 型出力モジュール付属

差動プローブ× 2、グランド・リード 当社 P7313SMA 型； 当社部品番号 196-3469-00

SMA ケーブル× 8 当社部品番号 174-1341-00、1 m または
当社部品番号 174-1428-00 1.5 m

3.3 V に設定された DC 電源× 1 Kenwood PW18-1.8AQ

入力アダプタ× 2 Efficere Technologies 社製品の EFF - HDMI - TPA - P および
EFF - HDMI - TPA - R

1. Select をクリックします。

2. Cable タブをクリックします。

3. Configure をクリックします。必
要に応じて、値を変更します
（通常はデフォルト値のままで
かまいません）。

Test Points 。テストする最
初のケーブルでは入力テス
ト信号（TP1）とケーブル出
力（TP2）の両方を検査する
ため、TP1 と TP2 を選択し
ます。この後のケーブル・テ
ストでは、TP1 の選択を解
除してください。

CRU。コンプライアンス・テ
スト用に PLL（デフォルト）
が選択されていることを確
認します。
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4. DTG タブをクリックします。DTG
で出力するクロックとデータの
テスト信号を設定します。

5. Cable Equalizer タブをクリック
して、設定オプションを選択し
ます。

6. Rise Time Filter タブをクリック
して、設定オプションを選択し
ます。
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7. Connect をクリックします。

8. テスト信号入力を検査する機
器を接続し、設定します。

TP1 セットアップ・ダイアグラ
ムに示されているように、テ
スト機器を接続します。

DTG とオシロスコープを接
続します。 (36 ページ 「テス
ト機器のリモート・コントロー
ルの有効化」 参照)。

注： ダイアグラムの のマー
クは、50 Ωターミネーションまた
は使用されていないプローブ入
力を示します。

注： シンク・テストまたはケーブル・テストを実行すると、GPIB バス・タイミングに関する警告が表示
されます。バス・タイミング・パラメータが 2 μs に設定されている場合、OK をクリックして続行してく
ださい。そうでない場合は、Cancel をクリックして、バス・タイミング・パラメータを変更してください。
(41 ページ 「GPIB バス・タイミングの設定」 参照)。
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9. Run Test をクリックします。

10.画面上に示される一連のメッ
セージの指示に従います。

11.テストが完了したら、テスト結果
を確認します。これらのテスト
結果から、テスト信号入力が規
格に準拠していることが立証さ
れます。 (15 ページ 「テスト結
果の分析」 参照)。

12.TPA-P-DI アダプタを取り外
し、セットアップ・ダイアグラムに
示されているように TPA-R-DI
アダプタを取り付けます。

注： ダイアグラムの のマー
クは、50 Ωターミネーションまた
は使用されていないプローブ入
力を示します。

13.ケーブル DUT を TPA-R-TDR
のアダプタ間に追加します。

14.Run Test をクリックします。

15.テストが完了したら、テスト結果
を確認します。合格した場合、
ケーブル DUT が HDMI に適
合していることを意味します。
(15 ページ 「テスト結果の分
析」 参照)。

16.Configure をクリックし、Test
Points を TP2 に設定します。

17.別のケーブル DUT に交換し、
Run Test をクリックします。

18.実行したテストに基づいた
レポートを生成できます。
(17 ページ 「レポートの生成と
印刷」 参照)。

テスト機器のリモート・コントロールの有効化

当社指定の DTG モデルと AWG モデルを使用する場合は、テストを実行する際に接続されたテスト機
器を TDSHT3 ソフトウェアで自動的に設定できます。指定以外の DTG または AWG を使用する場合
は、テスト機器を手動で設定する必要があります。

次の方法で行います。

AWG と DTG をリモート・コントロール用に接続する

GPIB アドレスをリモート・コントロール用に設定する
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次の機器が必要です。

当社 DTG5274 型または DTG5334 型および当社 AWG710 型、AWG710B 型または AFG3000 型
（2 チャンネル・モデル）または AWG7102 型または AWG7102

当社 TDS7000 シリーズのオシロスコープ、DPO70000 シリーズのデジタル・オシロスコープ、または
DSA70000 シリーズのデジタル・オシロスコープ

National Instruments GPIB-USB-B および添付ソフトウェア NI-488.2 for Windows

TDS シリーズ用の NI-488.2 ソフトウェア設定

注： オシロスコープにすでに NI-488.2 がインストールされている場合、手順 1 に説明されているバー
ジョンがインストールされ、インストール・パラメータが設定されていることを確認してください。正しくインス
トールされていない場合は、NI-488.2 をアンインストールし、手順 1 に従ってインストールしてください。

1. NI-488.2 for Windows （バー
ジョン 2.1 以上）をインストール
します。

インストール時：

2. NI-VISA はインストールしない
でください。

3. Measurement & Automation
Explorer をインストールします。

4. メッセージが表示されたら、
GPIB-USB インタフェースを有
効にします。

5. オシロスコープを再起動しま
す。

DPO70000/DSA70000 シリーズ用の NI-Software 設定

注： DPO70000/DSA70000 シリーズ用の NI ドライバを初めて使用する場合は、手順 6 から 14までを
実行してください。そうでない場合は、手順 12 から 14までを実行してください。
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6. オシロスコープのメニューで、
Utilities > GPIB Configuration

の順にクリックします。

7. GPIB 設定で、Controller を選
択します。GPIB Mode Switch
ダイアログ・ボックスが表示され
ます。

8. OK をクリックして、オシロスコー
プを再起動します。
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9. オシロスコープのメニューで、
Utilities > GPIB Configuration

の順にクリックします。

10.GPIB 設定で、Talk/Listen を
選択します。GPIB Mode Switch
ダイアログ・ボックスが表示され
ます。

11.OK をクリックして、オシロスコー
プを再起動します。

Start > Program メニュー
からは NI ソフトウェアに
はアクセスできません。
その代わり、C:\Program
Files\National

Instruments\NI-488.2\Bin

に移動します。

12.Add GPIB Hardware をダブ
ルクリックすると、Add GPIB
Hardware Wizard が表示され
ます。

13. リストから適切な NI ハード
ウェアを選択します（接続さ
れている場合は、リストから
GPIB-USB-B を選択します）。

14.Next をクリックしてインストール
を完了します。

注： DPO70000 シリーズまたは DSA70000 シリーズのオシロスコープには最初から NI ドライバがインス
トールされていますので、さらにインストールする必要はありません。
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機器の接続

15.USB-GPIB コントローラをオシ
ロスコープの USB ポートに接
続します。オシロスコープの
オペレーティング・システムが
USB-GPIB コントローラを検出
し、そのコントローラ用のドライ
バをインストールします。

16.GPIB ケーブルを使用して、
DTG コネクタと AWG/AFG
GPIB コネクタを GPIB コント
ローラの GPIB ポートに接続
（スタック接続）します。

テストで AWG/AFG を使用し
ない場合は、スタックされたコ
ネクタを AWG/AFG から取り外
し、オシロスコープと DTG 間を
GPIB-USB-B で接続します。

機器接続の確認

17.NI-488.2 ソフトウェアと共にイ
ンストールした Measurement
& Automation Explorer を開き
ます。

18.Configuration ペインの Devices
and Interfaces で、GPIB デバイ
スを右クリックします。

19.Scan for Instruments をクリック
します。

20.GPIB 機器番号とプライマリ・ア
ドレスを確認します。

21.機器を右クリックし、
Communicate with Instrument

をクリックします。

22.Query をクリックし、*IDN? に正
しい機器が表示されていること
を確認します。
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測定例

GPIB バス・タイミングの設定

23.GPIB デバイスを右クリックし、
Properties をクリックします。

24.Advanced タブをクリックします。

25.バス・タイミング・リストから、2
μs を選択します。

26.OK をクリックします（手順 38
までの手順をすべて完了し、ソ
フトウェアを終了してオシロス
コープを再起動してください）。
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測定例

GPIB アドレスの設定

27.TDSHT3 ソフトウェアを起動し
ます。

28.Select をクリックします。

29.Sink タブをクリックします。

30. Jitter Tolerance などの差動テ
ストを選択します。

31.Connect をクリックします。

32.Signal Sources をクリックします。

Tektronix DTG5274 型または
DTG5334 型ゼネレータに対して
次の操作を実行します。

33.DTG タブをクリックします。

34.GPIB をクリックします。

35.AWG タブをクリックし、同様に
GPIB をクリックします。

36.AFG タブをクリックし、操作を
繰り返します。

37.Test Conn をクリックし、正常に
接続されたことを示すメッセー
ジを確認します。

38.TDSHT3 ソフトウェアを終了
し、オシロスコープを再起動し
ます。
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索引

索引

記号と番号
1/2 スクリーン, 16

English terms
Advanced, 17
APP ボタン, 10
AWG の設定, 36
Calbe

Eye Diagram テスト, 33
Clear report, 17
Configure, 13
Configure ボタン, 12
Connect, 13
Connect ボタン, 12
CSV ファイル, 17
Detail, 18
DPO70000 シリーズ用の

NI-488.2 ソフトウェア設
定, 37

DTG の設定, 36
DTG5274 型, 42
DUT ID, 18
DUT の種類, 7
DUT の詳細, 18
EDID エミュレータ, 22
Efficere Technologies, 2
Enable Preview, 17, 18
Exit ボタン, 6
Fine（微調整）ボタン, 8
GPIB, 42
GPIB アドレス, 42
GPIB アドレスの設定, 42
GPIB バス・タイミング, 41
HDMI 規格への準拠, iv
Inter-Pair Skew テスト, 23
Jitter Tolerance テスト, 27
Pair, 17
Position eye mask in center, 9
Refresh Rate, 17
Report File, 17
Result Details, 15
Results ボタン, 12
RGT 形式, 17
RPL 形式, 17
RPT 形式, 17
RTF 形式, 17
Run Test, 14
Run Test ボタン, 12
Select, 12
Select All, 12, 20
Select ボタン, 12

Source
データ - データ間：

Inter-Pair Skew テス
ト, 23

Source タブ, 12
SVGA, 22
Tbit 値, 25
Tbit 値の再計算, 25
TDS シリーズ用の NI-488.2 ソ

フトウェア設定, 37
TekVisa, 1
Test Conn, 42
TPA-P-DI, 2
TPA-P-SE, 2
TPA-R-DI, 2
TPA-R-SE, 2
TPA-R-TDR, 2
Use oscilloscope settings for

image export, 18
VGA, 22
View Waveform, 14
View Waveform ボタン, 12

あ
アクイジション, 9
アプリケーションの概要, 7
アプリケーションの起動, 3
アプリケーションの再表示, 10,

11
アプリケーションの終了, 6
アプリケーションの非表示, 10
安全にご使用いただくため

に, iii

い
インストール, 1
インタフェース, 7
インタフェースの使用, 7

え
エラー・コード, 15

お
オシロスコープの汎用ノブ, 13

か
仮想キーパッド, 8
仮想キーボード, 7, 13

関連マニュアル, v

き
基本機能の設定, 9
基本設定, 9
キーボード, 7

く
クライアント・ペイン, 7

け
結果, 15
ケーブル・イコライザ, 33
ケーブル・エミュレータ, 29,

30, 31, 32

さ
最小／最大差動振幅公差テ

スト, 25

し
実行ペイン, 7
ジッタ校正, 29
出荷時のデフォルト値, 13
主要な機能, iv
詳細レポート, 17
シンク

差動：Jitter Tolerance テ
スト, 27

差動：最小／最大差動振
幅公差テスト, 25

信号ソース, 42

す
ステータス・バー, 7

せ
製品の説明, iv
接続, 2
ゼネレータの設定, 36
選択ペイン, 7
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索引

そ
測定例, 20

Cable テスト：Eye
Diagram, 33

Source テスト：Inter-Pair
Skew, 23

シンクのテスト：最小／最
大差動振幅公差, 25

シンクのテスト：ジッタ公
差, 27

ソースのテスト：すべて選
択, 20

ソフトウェアのアップグレー
ド, v

ソフトウェアの終了, 6
ソースのテスト

すべて選択, 20

た
タッチ・スクリーン, 7

て
テスト

操作手順, 12
テスト ID, 12
テスト ID 5-3, 33
テスト ID 8-5, 25
テスト ID 8-7, 27
テスト機器, 36, 40

接続, 13
設定, 2

テスト機器の接続, 36
テスト機器の設定, 36
テスト結果, 15
テスト結果の表示, 15
テストの実行, 12
テスト・パラメータ

設定, 13

の
ノブ, 8, 13

は
汎用ノブ, 8, 13

ひ
ピクセル・クロック・レート, 22
被測定装置の種類, 7
非表示アイコン, 10

ふ
ファイル

アプリケーションの実行, 3
終了, 6
設定, 9

複数のテスト, 12
複数のテストの選択, 12
プローブの校正, 5
分解能, 17

ほ
方法

アプリケーションの操
作, 12

ソフトウェアのインストー
ル, 1

テストの実行, 12
ボタン, 7

ま
マウス, 7
マニュアル, v

め
メニュー, 7
メニュー・バー, 7

り
リモート・コントロール, 36

れ
レポートの印刷, 17
レポートの生成, 17
レポートのファイル形式, 17
レポート・サマリ, 17
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